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IBM Marketing Platform Release Notes

Chapter 1. About IBM Marketing Platform version 9.1.2
This document describes the new features and changes introduced in the 9.1.2
version of Marketing Platform and earlier versions in the 9.1.x line.

Where to find complete system requirement and compatibility
information
For a list of IBM® EMM product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software
Environments and Minimum System Requirements document. This document is posted
under Detailed System Requirements on the IBM Support Portal website:
(http://support.ibm.com).
You can also access this document by selecting Help > Product documentation
when you are logged in to IBM EMM.

New features and changes in version 9.1.2
This section describes the new features and changes introduced in the 9.1.2 version
of Marketing Platform. For complete details on new features, see the IBM
Marketing Platform 9.1.2 Administrator's Guide.

Security framework API
Marketing Platform provides the security framework for the APIs implemented by
IBM EMM products.
The Marketing Platform security framework supports the following two
authentication options for accessing protected APIs. You can use either one,
depending on your environment.
Internal users who are registered with Marketing Platform can be authenticated
using their Marketing Platform login credentials to obtain a secure token.
v External users who are part of a federation that Marketing Platform is set up to
use can be authenticated though the Identity Provider server.
v

See the IBM Marketing Platform Administrator's Guide for additional details.

Dynamic token support in custom dashboard portlets
When you define a custom dashboard portlet, you can now pass pre-defined
tokens that are replaced with the values stored in Marketing Platform for the
current user when the portlet is invoked.
v <user_name>
v <user_first_name>
v <user_last_name>
v <user_email>
See the IBM Marketing Platform Administrator's Guide for additional details.
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Configuration property added to control the Scheduler in a
clustered environment
A new JVM configuration property has been added to disable the IBM EMM
Scheduler in the Marketing Platform JVM when Marketing Platform is deployed in
an application server cluster.
In a clustered environment, the various instances of the IBM EMM Scheduler
provided by Marketing Platform all try to perform scheduling tasks, which can
result in conflicts.
To address this situation, you can use the new JVM level parameter
DISABLE_SCHEDULER_CLIENT_ON_CURRENT_NODE with the -D option to disable the
Scheduler on all nodes except one. Example:
-DDISABLE_SCHEDULER_CLIENT_ON_CURRENT_NODE=true

This example disables the Scheduler on the application server clustered node. If
you configure this JVM parameter on all nodes except one, then all scheduled jobs
are executed on the application server cluster node which where this parameter is
not set.
Note: If the working node (enabled Scheduler client) goes down, no scheduled
tasks run.

Page tagging
If page tagging is disabled, the page tagging java script (/js/ntpagetag.js) file is
not created. (Enhancement 173856)

Fix for LDAP error
You can now disable LDAP paged search logic by adding the Java option
-DLDAP_PAGE_SEARCH_DISABLED=TRUE in WebSphere when Marketing
Platform is deployed on WebSphere.
This is applicable only when the following exception is present in the Marketing
Platform system log.
FATAL - No matching response control found for paged results - looking for
’class javax.naming.ldap.PagedResultsResponseControl

(Enhancement 179082)

Logging improvements
Logging for Scheduler and LDAP events has been improved. (Enhancement
173654)

Fix for password changes
Before allowing users to change their passwords, the system now requires users to
insert their current passwords. (Enhancement 177831)

Character support in federated SSO user names
In the federated SSO feature, support for the following two characters in user
names was added.
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v Dot (.)
v The at sign used in email addresses (@)
(Enhancement 184395)

New features and changes in version 9.1.1
This section describes the new features and changes introduced in the 9.1.1 version
of Marketing Platform. For complete details on new features, see the IBM
Marketing Platform 9.1.1 Administrator's Guide.

Support added for SAML 2.0 based federated authentication
Marketing Platform supports SAML (Security Assertion Markup Language) 2.0
federated authentication, which enables single sign-on access among diverse
applications.
You can use federated authentication to implement single sign-on between IBM
EMM applications and other IBM applications or third-party applications
The Marketing Platform installation includes the following components that
support federated authentication.
v An identity provider server
v A client JAR file that you can use with Java applications to generate and parse
SAML 2.0 assertions. The Java products that you integrate with IBM EMM use
the assertions to communicate with the identity provider server.
Contact your IBM representative to learn more about this feature.

Audit event tracking and reporting
A new Audit Events report is introduced with the 9.1.1 release of Marketing
Platform. You can configure which audit events are tracked and assign a severity
level to each tracked event.
The Audit Events report provides a convenient way to view the tracked events.
You can configure the content of the report, filter the information shown in the
report, and export report data.
Two kinds of audit events are tracked:
v Security related events such as changes to user status, group memberships, and
permissions
v Changes to IBM EMM configuration properties that are managed on the Settings
> Configuration page
You must have the AdminRole or PlatformAdminRole role in Marketing Platform
to configure the Audit Events report and audit backups or to view the report.

Data filter enhancement
The data filter feature has been enhanced to make it easier to configure data filters
based on user logins.
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When you have a filter based on user logins, you can now use the #user_login#
wild card to assign data filters to users or groups of users. At run time, the wild
card value is replaced by the current user's login. This eliminates the step of
creating one filter for each user.
Here is an example of the XML you would create to add all members of the
FieldMarketers group to a data filter.
<DataFilter>
<configId>1</configId>
<id>1</id>
<fieldConstraints>
<FieldConstraint>
<logicalFieldId>3</logicalFieldId>
<expression>#user_login#</expression>
<!-- This is the wild card. -->
</FieldConstraint>
</fieldConstraints>
</DataFilter>
<AssignmentByName>
<namespaceId>1</namespaceId>
<dataObjectId>1</dataObjectId>
<!-- This is a reference to the filter.-- >
<principalType>2</principalType>
<!-- This is the type of assignment: 1 is for assigning to a user,
2 is for assigning to a group of users. -->
<principalName>FieldMarketers</principalName>
<!-- This is the name of the group to which you assign the filter.-->
</AssignmentByName>

Note that you still have to create the XML to set up the data filters themselves, as
described in the IBM Marketing Platform Administrator's Guide.

Interaction History and Attribution Modeler are not supported
Interaction History and Attribution Modeler are not available for version 9.1.1.
Enterprise Marketing Management products on version 9.1.1 do not support
integrations with version 9.1.0 of Interaction History and Attribution Modeler.

IBM Knowledge Center
All product documentation is now available in the IBM Knowledge Center at:
http://www.ibm.com/support/knowledgecenter/
You can browse or search within or across product families to find the topics that
you need. To search within a single product, expand a product family in the Table
of Contents, select a product, then enter your search term. Click the X in the
toolbar to clear the Search Filter. For more information, click the Help icon at the
top right of the toolbar.

New features and changes in version 9.1.0
This section describes the new features and changes introduced in the 9.1.0 version
of Marketing Platform. For complete details on new features, see the IBM
Marketing Platform 9.1.0 Administrator's Guide.
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The IBM EMM Scheduler has been enhanced
The following enhancements are added for the IBM EMM Scheduler.
v Scheduler management pages now display additional information.
On the Schedule Definitions page, you can find scheduled items and use links to
navigate to them.
A new column on the Schedule Definitions page lists the last two runs and the
next run of recurring schedules. (ENH18928, ENH18914)
Additional details about individual runs have been added on the Scheduled
Runs page, and you can also cancel selected runs on this page.
v A new configuration property, Platform | Scheduler | Enable Scheduler, allows
you to disable the scheduler if your organization does not use it.
Disabling the scheduler frees additional system resources and can improve
performance.
v A new configuration property, Platform | Scheduler | Maximum Unknown
Status Polling Count allows you to specify the number of times the scheduler
checks the status of a scheduled run for which the status cannot be determined.
After this limit is reached, the run status is listed as Unknown on the Settings >
Scheduled Tasks page. This can help administrators identify runs that are
having problems.

Notifications are available for the IBM EMM Scheduler
Administrators and users who create schedules can now set up notifications, to
monitor the status of scheduled runs. Notifications can be sent to the user's email
or system in box.
Users with Administrator permissions in Marketing Platform can set up groups of
users to whom schedule notifications are sent.

Support for clustering has been added
Marketing Platform, including the IBM EMM Scheduler, now supports clustering.
A new configuration property, Platform | Is this deployment clustered, has been
added as part of this support. This property must be set to True for a clustered
environment.
In this release, Marketing Platform is supported for a clustered environment, but
eMessage is not supported.
In this release, clustering is supported only when Marketing Platform is deployed
on WebSphere®. (RTC8834)

The configTool utility has a new option for manual upgrades
A new -vp command in the configTool utility has been introduced. It is used
mainly in manual upgrades, to import configuration properties. If you applied a
fix pack that contains a new configuration property, and you then upgrade,
importing a configuration file as part of a manual upgrade process can override
values that were set when the fix pack was applied. The -vp command ensures
that the import does not override previously set configuration values.

Chapter 1. About IBM Marketing Platform version 9.1.2
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When you use -d with the -vp command, the configTool deletes any child nodes in
the path you specify if those nodes are not included in the XML file you specify.
See the IBM Marketing Platform Administrator's Guide for complete details on the
configTool utility.

Sorting performance has improved for alerts, notification, and
scheduler pages
Server side sorting has been implemented for the column sort feature to improve
performance on the alerts, notification, and scheduler pages. This is especially
noticeable when you use the column sort feature on a large number of records.

Single sign-on is enabled with IBM SPSS® Modeler Advantage
Enterprise Marketing Management Edition
If your organization uses IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition, you can enable single sign-on with IBM EMM. Single sign-on
allows users to navigate to IBM SPSS Modeler Advantage Marketing Edition from
within the IBM EMM user interface without being prompted to log in.
See the IBM Marketing Platform Administrator's Guide for instructions on configuring
single sign-on.

IBM EMM installation and upgrade improvements
The improvements to the installation and upgrade process include:
v Installation guides for all products have been rewritten and reorganized into
separate installation and upgrade guides, to make information easier to find and
use.
v The installers have been enhanced to include better descriptions of the
information you need to enter and to clarify what steps to take during each
stage of the installation.
v Each installer now provides links directly to the product's installation and
upgrade guides, in either PDF or HTML formats.

Browser behavior in IBM EMM products
IBM EMM products have certain browser restrictions and requirements.

Supported browsers
For a list of supported browsers, see the IBM Enterprise Marketing Management
Recommended Software Environments and Minimum System Requirements for version
9.1.0.

Pop-up blockers
You must disable any pop-up blockers in your browser or browser add-ons, such
as toolbars. Pop-up blockers prevent the flowchart window from opening.

Navigation methods
Do not use the browser controls to navigate. For example, avoid using the
browser's Back and Forward buttons. Instead, use the controls supplied in the IBM
EMM user interface.
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Using multiple browser windows in Internet Explorer
This restriction applies to using Internet Explorer (IE) with IBM Campaign or any
module that uses Campaign flowcharts (eMessage, Contact Optimization, Interact,
Distributed Marketing).
To log in multiple times to view side-by-side information, you must open IE and
log in to IBM EMM. Then select File > New Session in the IE menu bar. In the
new IE browser window, log in to IBM EMM as the same or a different user.
Important: Do not use any other method to open multiple sessions. For example,
do not open a new tab; do not open another browser session from the Start menu
or desktop icon; and do not use File > New Window in IE. These methods can
corrupt information that is shown in the application.
For details, see the IBM Campaign User's Guide.

Chapter 1. About IBM Marketing Platform version 9.1.2
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Chapter 2. Fixed defects
This section describes the fixed defects in the 9.1.2 version of Marketing Platform.
PO03992, APAR
173470

Cross site scripting issues existed on the dashboard portlet creation
page and the data source creation page. This has been fixed.

PO04188, APAR
176943

A security issue resulted from validation not being performed on some
input fields. This has been fixed.

P000051, APAR
168778

When Marketing Platform was configured to integrate with Windows
Active Directory, and when a user created in Marketing Platform had
the same user name as an Active Directory user, that internal user
could log in to Marketing Platform with the Active Directory user's
password,even when the Active Directory external user was not
synchronized. This has been fixed.

PO03160, APAR
158353

When an IBM Scheduler task was configured to run after two or more
other tasks completed successfully, and if one of the runs failed, a
dependent task ran, when it should not have run. This issue has been
fixed.

PO04000, APAR
173576

The value of the portletURL request parameter in a custom dashboard
portlet could be intercepted and a third party URL could be injected.
This has been fixed.

PO04344, APAR
179416

When authenticated mode was configured in IBM EMM Reports, there
was a security vulnerability in the error message that was displayed
when an incorrect user name was entered. This has been fixed.

PO04026, APAR
174004

When Authentication mode was set to authentiactedPerUser in IBM
EMM Reports, external users could not access the Cognos reports
through Campaign Analytics. This has been fixed.

PO04301, APAR
178789

After Campaign was upgraded from version 8.6 to version 9.1.0.0,
users could not access the User Roles & Permissions page. This has
been fixed.

PO04307, APAR
178917

When the environment was configured to use the French region and
locale, the IBM EMM Scheduler default recurrence definitions
translated in French did not clearly define midnight. This has been
fixed.

PO04509, APAR
182201, DEF
182204

When you installed Marketing Platform and selected an option in the
IBM Page Tagging field, the installer did not set the value of the
corresponding configuration property correctly. This has been fixed.

PO04539, APAR
182563, DEF
182566

When you scheduled a Campaign flowchart and added a new
notification by clicking Edit Job Notifications, your changes were not
applied and the notification reverted to the default setting. This has
been fixed.

PO04446, APAR
181284, DEF
181278

A scheduled job based on a trigger failed to run because the schedule
that sent the trigger was not deleted from the Quartz tables, so it was
still in "running" status. This has been fixed.

APAR PO04734,
APAR 186158,
DEF 186163

The Reports SQL Generator did not update the header completely. If
you opened a dashboard page and then navigated to the Reports SQL
Generator, the part of the header under the title was not refreshed and
remained from the previously visited page. This has been fixed.

© Copyright IBM Corp. 1996, 2015
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PO04707, APAR
185697, DEF
185700

If Marketing Platform system tables were in Oracle and you applied
fixpack 9.1.1.2 on Marketing Platform and Campaign, the Campaign
Global Policy roles on the User Roles ) Permissions page were
displayed with inconsistent sorting. This has been fixed.

PO04495, APAR
181891, DEF
181896

Cross-site scripting security issues have been fixed.

APAR PO02558,
DEF 134139

Header types were missing for static content such as image, .js and .css
files. This has been fixed.

APAR PO03696,
DEF 168191

The IBM EMM Scheduler allowed a Campaign flowchart to be
scheduled for a past date and time. This has been fixed.

APAR PO03491,
DEF 164112

A custom dashboard portlet created using a URL did not show the
report. This has been fixed.

APAR P000051,
DEF 168780

An internal user could log in using the password of an external user in
Windows Active Directory, if both accounts had the same user name,
even when the external user was not synchronized. This has been
fixed.

APAR PO02808,
DEF 154710

a scheduled flowchart run failed when a campaign was moved to
another folder or renamed. This has been fixed.

APAR PO04224,
DEF 177600

A cross site scripting issue occurred. This has been fixed.

APAR PO03160,
DEF 158354

When a schedule was configured using On completion of other tasks,
a dependent run task fired inappropriately because some run cycle
results were not considered. This has been fixed.

APAR PO03993,
DEF 173479

When the system archived notification alerts, the following errors
occurred.
Integrity constraint XUNICA.FK_USM_SUITE) violated
-child record found.
This has been fixed.
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APAR PO04188,
DEF 176949

Validation was not performed on dashboard name input fields for the
<Button> html tag. This has been fixed.

APAR PO04213,
DEF 177424

The change password page was vulnerable to a cross-site request
forgery attack. This has been fixed.

APAR PO04000,
DEF 173578

For the dashboard custom iframe portlet, a URL was passed as a
request parameter, which was an open redirection vulnerability
security issue. This has been fixed.

APAR PO04026,
DEF 174007

If Oracle was used for Marketing Platform system tables, external
LDAP and Siteminder users were unable to access Cognos reports
through Campaign Analytics. This has been fixed.

PO04448, APAR
181309, DEF
181308

"Authentication failed" errors occurred on user login when single
sign-on with IBM Digital Analytics was configured to create IBM
Digital Analytics user accounts automatically. This has been fixed.

APAR PO04301,
DEF 178784

When IBM Campaign had multiple partitions, and Marketing Platform
and Campaign were both upgraded or had a fixpack applied, users
were seeing an "Internal system error" when they tried to log in or
open the Roles & Permissions page. This has been fixed.

APAR PO04344,
DEF 179417

The error message that users saw when they tried to log in to Cognos
with an invalid user name had a security vulnerability. Users now see
a generic error message.

IBM Marketing Platform Release Notes

PMR173463, DEF
173471

Cross site scripting issues occurred in the portlet name when a user
created a custom portlet, and in the data source name when a user
created a data source for a Marketing Platform user. This has been
fixed.

APAR PO04307,
DEF 178919

When the environment was configured to use the French region and
locale, theIBM EMM Scheduler default recurrence definitions did not
clearly define whether noon or midnight was referenced in the cron
expression. This has been fixed.

APAR PO04364,
DEF 179922

A report could not be scheduled in Cognos when the Report
authentication mode was UnicaSecure namespace. This has been fixed.

APAR PO04707,
DEF 185700

If Marketing Platform system tables were in Oracle and you applied a
FixPack on Marketing Platform and Campaign, the Campaign Global
Policy roles on the User Roles ) Permissions page were sometimes
displayed with inconsistent sorting. This has been fixed.

APAR PO04617,
APAR 183980,
DEF 183982

If you used the scheduler_console_client utility to send a scheduler
trigger, a NullPointerException occurred, and the actual cause of the
failure was not captured. This has been fixed.

APAR PO03710,
DEF 168327

If a user clicked the Submit button multiple times, an error occurred
and the user was logged out from the application even if the first
request was successfully processed. This has been fixed.

APAR PO04317,
DEF 178898

If a you used the IBM EMM Scheduler to schedule an IBM Contact
Optimization session and you clicked Scheduled Task > Scheduled
item, you saw a javascript error page. This has been fixed.

APAR PO04764,
DEF 186880

In the Marketing Platform system table database, if the PAYLOAD field
in the USCH_RUN table contained a NULL value, the schedule failed
with a NullPointerException error. This has been fixed.

Chapter 2. Fixed defects
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Chapter 3. Known issues
This section describes the known issues in the 9.1.2 version of Marketing Platform.
Email alerts for
scheduled tasks
are not sent

PMR
Email alerts for scheduled tasks are sometimes not sent,
198383,
although the notifications still appear in the user
PMR
interface. To work around this issue, increase the value
197780, DEF of the How many days to retain alerts configuration
198532
property under the IBM Marketing Platform |
Notifications category to 365.

Unable to open
DEF 195923
eMessage editor
when the
Marketing
Platform audit
feature is enabled.

To work around this issue, disable the following audit
events under the IBM Marketing Platform | Audit
Events | Audit Events Configuration category on the
Settings > Configuration page.
v Record role creation or deletion
v Record role membership changes
v Record role permission changes
Restart all of your applications

Job notifications
are vulnerable to
attacks because
the notification
names are
processed

DEF 193847

Showing all
APAR
scheduled tasks or PO04977,
runs is not
DEF 191457
practical with
large number of
records

If a user enters javascript or HTML in the job
Notification Title field, the data is processed when the
user clicks Save. This is a security risk.

With the All pagination link active, the Scheduled tasks
and Scheduled runs pages are unresponsive when a large
number of records are present or when a user clicked
Refresh. Avoid showing all records when you have a
large number of schedules or runs.

Poor performance
for some
schedules

APAR
Scheduling multiple runs over a long period of time
191593, DEF causes poor performance.
189379

Error when
deleting some
schedules

APAR
PO04930,
DEF 190408

An exception occurrs when you delete old trigger based
schedules.

Dashboard issue
with partitions

APAR
PI35736,
DEF 185447

When Marketing Platform is in a multi-partition
environment and is integrated with Cognos for
reporting, dashboard portlets may show only partition1
data for all partitions.
The solution is to configure a different value for the
following configuration property for each partition:
Affinium|Campaign | partitions | partition[n] |
reports |analysisSectionFolder .

NULL value
causes failed
schedule

APAR
PO04764,
DEF 186880

In the Marketing Platform system table database, if the
PAYLOAD field in the USCH_RUN table contains a
NULL value, the schedule fails with a
NullPointerException error.

Blank report
portlet in Chrome

APAR
PO05120,
DEF 194413

When a Cognos Report custom portlet was created in
Dashboard, it was blank in Chrome.

© Copyright IBM Corp. 1996, 2015
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Location of
installer logs is
incorrectly
displayed for
AIX®

DEF 178861

The location of the installer logs stdout and stderr is
incorrectly displayed in the installer wizards when the
home directory of user is set to /, which is the case for
the root user on AIX. It is not a requirement to run the
IBM EMM installers as root. If you do run the installers
as root on an AIX system, you can find the logs in the //
directory.

In a clustered
environment,
manual LDAP
synchronization
fails if the active
node goes down

DEF 23676,
DEF 178856

In a clustered installation, if you synchronize LDAP
users manually, one of the nodes in the cluster connects
with the LDAP server to perform the synchronization. If
the node that is performing the synchronization goes
down before the synchronization is completed, an error
occurs, and you cannot restart the manual
synchronization until the process times out.
The default value for this timeout is set to 600 minutes in
the Platform | Security | Login method details | LDAP
synchronization | LDAP sync timeout configuration
property. You can set this value to a lower number.

IBM SPSS
DEF 67409
Modeler
Advantage
Marketing Edition
session persists
across single
sign-on users

If you access IBM SPSS Modeler Advantage Marketing
Edition through Marketing Platform using an account
enabled for single sign-on, and you close the IBM SPSS
Modeler Advantage Marketing Edition browser window
without logging out, any other users who log in from the
same browser to IBM SPSS Modeler Advantage
Marketing Edition using single sign-on are logged in
with the first user's session.
If you share a computer and browser with another EMM
user where both you and the other user access IBM SPSS
Modeler Advantage Marketing Edition using single
sign-on, you must log out of IBM SPSS Modeler
Advantage Marketing Edition before you close any
modeling stream window. This prevents anyone else who
uses the same browser to access IBM SPSS Modeler
Advantage Marketing Edition from using your IBM SPSS
Modeler Advantage Marketing Edition credentials.

Schedule fails
DEF 72022,
when non-ASCII
DEF 063677
characters are
used in scheduled
objects

If you configure a scheduled run for a Campaign
flowchart or other object that was created using
non-ASCII characters (such as Chinese), the schedule
fails.

When you install
the report
component, the
Marketing
Platform installer
is sometimes
unable to create
some required
directories on the
Cognos® machine

The account used to run the installer should have
permissions to write in the following folders under the
Cognos installation.

DEF 72226,
DEF 95402

v configuration
v webapps\p2pd\WEB-INF\AAA\lib
v templates\ps
v webcontent\schemas
v bin
If the installation was run with an account that does not
have these permissions, after installation, you can log in
to the Cognos machine with an account that does have
the required permissions, and then run the
copyCognosFiles.bat script, which is located in the
tools\cognos10 directory under the Marketing Platform
installation.
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Text in the Detail
column on the
Scheduled Runs
page is not
translated

DEF 73856

On the Scheduled Runs page, the content in the Details
column is not translated.

When you use the DEF 75262
browser's Back
button to navigate
in IBM EMM
products, the UI
can be distorted

You should use links within the products to navigate in
IBM EMM products, rather than the browser's Back
button.

Marketing
Platform upgrade
from 8.5 to 9.1
completes with
errors in the
installation log

The upgrade from Marketing Platform version 8.5 to
version 9.1.0 may complete with the following message
in the installer log.

DEF 103371

The DELETE statement conflicted with the REFERENCE
constraint "FK_USM_RPM_ROLE". The conflict occurred
in database database_name, table
"dbo.USM_ROLE_PERMISSION_MAP", column ’ROLE_ID’.
If this error occurs after you have run the installers as
described in the Marketing Platform 9.1.0 Installation
Guide, perform the following step to resolve the issue.
Run the following SQL statement against your Marketing
Platform system table database.
DELETE FROM USM_ROLE_PERMISSION_MAP
WHERE ROLE_ID IN (SELECT ID from USM_ROLE
WHERE APPLICATION=(SELECT APP_ID from
USM_APPLICATION WHERE APP_ID=106));
DELETE FROM USM_ROLE WHERE APPLICATION = 106;

Chapter 3. Known issues

15

If you change the
time zone in an
existing
reoccurring
scheduled task,
the CRON
expression is not
updated

DEF 121378

When you set up a recurring scheduled task in the IBM
EMM Scheduler, the CRON expression for that task
reflects the specified time relative to the time zone of the
Marketing Platform server. If you later change the time
zone setting on the scheduled task, the CRON expression
does not adjust the time to reflect the specified time zone
relative to the time zone of the Marketing Platform
server.
For example, suppose EDT is the time zone of the
Marketing Platform server. If you set up a recurring task
to start on some date at 11:30:00 am in the EDT time
zone, the CRON expression reflects an
hour/minute/second of 11:30:00 am. If you set up a
recurring task to start on some date at 11:30:00 am in the
GMT time zone, the CRON expression reflects an
hour/minute/second of 6:30:00 am because the
Marketing Platform server timezone is EDT and GMT is
5 hours earlier than EDT.
Using the above example, if you modify an existing
scheduled task specify a different time zone, the CRON
expression defined for that task does not adjust to the
new time zone. For example, if you change an existing
task set up for 11:30:00 am on EDT to 11:30:00 am GMT,
the task still shows a CRON expression of 11:30:00 am
for hour/min/second, where it should show 6:30:00 am.
You can use either of the following workarounds to
resolve this issue.
v Delete the existing recurring scheduled task and
recreate a new one with the new time zone.
v When you update an existing recurring scheduled task
that needs a time zone change, modify the time zone
but then re-enter the recurrence pattern and save the
task. This should update the CRON expression.

Users can not log
out from
Campaign or
Marketing
Platform pages
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DEF 121489

When Campaign is installed with any other IBM EMM
products, you can not log out from Campaign or
Marketing Platform pages. The work around is to go to
any product page other than Campaign or Marketing
Platform pages, and log out from there.

Users with
DEF 131626
non-ASCII
characters in their
user name can not
log in to IBM
SPSS Modeler
Advantage
Marketing Edition
using single
sign-on

There is no workaround for this issue at this time.

A javascript error
may occur when
you edit a
scheduled task.

When you edit a scheduled task on the Schedule
Definitions page, a JavaScript error may be displayed in
a pop-up window when you click Save Changes. This
issue occurs only when the Display a notification about
every script error option is set in Internet Explorer. Your
changes are saved despite this error.
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DEF 176909

During the
uninstall process,
the installer does
not perform data
backup when the
operating system
uses the Japanese
locale

DEF 177516

When you choose to back up data during the uninstall
process on a Japanese operating system, the backup fails
with the following error message: The garbage
characters are logged in
product_uninstall_stderr.log.
The workaround is to perform a manual backup before
starting the uninstall process.

Chapter 3. Known issues
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Chapter 4. Known limitations
This section describes the known limitations in the 9.1.2 version of Marketing
Platform.
Reports folder DEF 045222
permissions are
synchronized
across
partitions

In a multi-partition environment, if you synchronize
reports folder permissions in one partition, the folder
permissions for other partitions are also added to that
partition. The synchronization of folders that do not
belong to the current partition does not cause any
authorization problems.

Deleting an
LDAP group
mapping does
not remove
users from the
mapped group

DEF 047290

When you delete an LDAP group mapping on the
Configuration page, users that were imported into the
mapped group are not removed from that group. You
should remove the users from the group manually.

Some
Campaign
configuration
properties are
incorrect after
upgrade

DEF 045746

After you upgrade Campaign from version 7.x to 8.1.0,
some configuration properties are incorrect.
v "Affinium" appears in some property display names.
This naming inconsistency does not affect
functionality.
v Under the Campaign category, the unicaUdiSvr
category and its properties appear, although they are
not used in Campaign 8.1.0.
You can use the configTool utility to remove "Affinium"
from display names or remove the unicaUdiSvr category.
Here is an example of how you would do this
v Open a command window in the tools/bin directory
under your Marketing Platform installation.
v

Use configTool to export all the Campaign properties
to a file. The following example command exports the
properties to a file named campaignProperties.xml in
the tools/bin directory.
configTool -x -p "Affinium|Campaign" -f
campaignProperties.xml

v Edit the exported file in a text or XML editor.
v

Use configTool to import the revised file, using the
overwrite option. For example:
configTool -i -p "Affinium" -f
campaignProperties.xml -o

Partition
memberships
are lost during
7.2.x to 7.5.x
upgrade
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DEF 046155,
DEF 046162

If your version of Affinium Manager is earlier than 7.5.x,
you must upgrade to 7.5.1 before you upgrade to
Marketing Platform version 8.x. The upgrade scripts for
Affinium Manager 7.5.1 do not automatically preserve
partition membership. Instead, you must manually
restore partition membership before you upgrade to
Marketing Platform 8.x. This process is described in the
Marketing Platform Installation Guide.
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Active
DEF 046778
Directory users
cannot log in
to NetInsight
or Customer
Insight

When Marketing Platform is integrated with Active
Directory, a user synchronized from Active Directory or
an LDAP server cannot log in to Digital Analytics for On
Premises or CustomerInsight.

Uninstalling an DEF 047048
IBM EMM
application
does not
remove its
menu items

If you uninstall an IBM EMM application, the menu
items for that application remain on the Configuration
page. You can remove them by going to the
Configuration page, locating the appropriate menu
settings under the Platform | Platform-wide navigation
category, and clicking Delete category.

An error
occurs when
you cancel a
report run

DEF 047550

When you cancel a running report and then try to run
another report, an error message is displayed. You
should select the Analytics menu and run the report
again.

Uninformative
error message
appears when
you enter a
role name that
exceeds length
limit

DEF 047639

When you enter a role name longer than 120 characters
(the length limit), the error that appears reads "Error
500-Internal Server Error." The message should indicate
the length limit.

Logout link is DEF 047870
redundant with
Windows
integrated
login

When Marketing Platform is integrated with Windows
Active Directory and Windows integrated login is
enabled, you can not log out using the Log Out link.
When you click Log Out, your browser session ends and
it appears that you are logged out of IBM EMM, but
then you are automatically logged in again. You should
close your browser when you log out of IBM EMM.

When you use
Edit
Preferences to
set a Start
page, you
cannot use an
IBM EMM
URL

DEF 050523

If you set a Start page for a user using the Edit
Preferences page for that user, you should not use the
initial IBM EMM login URL (http://host:port/unica ),
or you will encounter problems.

Non-ASCII
characters not
allowed in
throttling
group names

DEF 050689

When you create a throttling group for the scheduler, an
error message appears if you use non-ASCII characters.
Use only ASCII characters in throttling group names.
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Errors occur
during
upgrade from
7.5.x to 8.x

DEF 050735

When you upgrade from Affinium Manager 7.5.x to
Marketing Platform 8.x, the data source keys stored in
your existing Manager system tables must be
un-encrypted and then re-encrypted to be stored in the
database for 8.x.
If you have changed your keystore password in 7.5.x
using (encryptPasswords -k), and if Platform is not
installed on AIX, you can use the following procedure to
correct the problem.
Note that this workaround does not apply when the
Platform is installed on AIX. In that case, you must log
in to IBM EMM and change data source passwords
manually.
This procedure ensures that you have the latest Java™
Cryptography Extension (JCE) Unlimited Strength
Jurisdiction Policy Files 5.0.
Download these files here: http://java.sun.com/javase/
downloads/index_jdk5.jsp
Scroll to Java Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy Files 5.0 and do the
following.
1. Ensure that the JRE in your Manager 7.5.x installation
has the updated JCE Unlimited Strength Jurisdiction
files. Follow instructions in the download to copy the
local_policy.jar and US_export_policy.jar to the
jre/lib/security directory.
2. Use encryptPasswords -k to encrypt your keystore
password again.
3. If you are NOT using the JRE provided in the
Platform installer, also update the JCE Unlimited
Strength Jurisdiction files for the JRE you intend to
use.
4. Run the Platform installer and your keys will be
migrated to 8.x.
If the JCE updates are not made, or if you were unable
to use the workaround because your Platform system
table database is AIX, you may see these errors:
Cannot retrieve the key from the file
[<INSTALL_DIR>\Affinium\Manager\conf\kfile], cause:
Illegal key size
javax.crypto.BadPaddingException: pad block corrupted
If these errors occur, log in to IBM EMM and change
data source passwords manually.

User names
cannot contain
spaces or
punctuation
characters

DEF 051877

If a user's login name contains a space or punctuation
character, a JavaScript error appears on every page,
although the user can navigate and use IBM EMM
normally. Do not include spaces or punctuation
characters in login names of user accounts.

Chapter 4. Known limitations
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Non-ASCII
DEF 051431
characters are
not supported
for group, role,
and policy
names

If you attempt to use non-ASCII characters in group,
role, or policy name, you see the following error
message: Please use only alphanumeric characters. You
should not use non-ASCII characters in these names.

Duplicate role
names are not
allowed

DEF 051895

In Affinium Manager 7.5.x, duplicate role names were
allowed. Starting with Marketing Platform 8.0.0,
duplicate role names are not allowed. If you upgrade
from 7.x to 8.x, and you have multiple roles with the
same name, you should rename roles so that no
duplicates exist before you upgrade.

Installer
message for
directory to
upgrade
Platform 7.5.x
is confusing

DEF 051952

When you upgrade Marketing Platform 7.5.x to 8.1.0, the
installer prompts you to specify the directory where the
7.5.x version is installed. If the installer cannot find the
installation registry in that directory, it displays the
following message: Manager Upgrade directory
specified [directory] was not found by the
installer. If you see this message during upgrade, you
should verify that the specified directory is the correct
one, and then proceed with the upgrade.
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Chapter 5. Issues related to third-party software
This section describes the issues in the 9.1.2 version of Marketing Platform that are
related to third-party software.
The uninstall
process does
not remove all
of the
directories
created by the
installer

DEF 8616, DEF The Marketing Platform un-installation process should
64640
remove all the directories created by the Marketing
Platform installer. A fix has been requested from
InstallAnywhere.

You can not
DEF 130030
schedule an
IBM EMM
Scheduler task
with an
interval greater
than 60
minutes

With CRON expressions, it is not possible to construct
intervals longer than 59 minutes, because 60 minutes
would change the hour. Similarly, it is not possible to
specify 70 minutes, or 74 minutes for recurring tasks. The
workaround is to specify two schedules for the same
object, with staggered start times.
For example, suppose you want to specify a 90 minute
interval between runs of a flowchart. You could set up
two recurring schedules as follows.
v Schedule A
– Start time: 7 am
– Interval: 3 hours
This schedule causes the flowchart to run at 7 am, 10
am, and so on.
v Schedule B
– Start time: 8:30 am
– Interval: 3 hours
This schedule causes the flowchart to run at 8.30 am,
11.30 am, and so on.

© Copyright IBM Corp. 1996, 2015
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Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
B1WA LKG1
550 King Street
Littleton, MA 01460-1250
U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.
Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.
Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.
IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices
For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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Before you contact IBM technical support
If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.
If you are not a designated support contact at your company, contact your IBM
administrator for information.
Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather
Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain
as described in "System information."

System information
When you call IBM technical support, you might be asked to provide information
about your environment.
If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.
You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support
For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).
Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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